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1 Introduction 
1.1 About This Guide 

This document is intended for engineers responsible for building MOTOTRBO radio 
networks and programming two-way radios for end users. 

1.2 About TRBOnet Swift 
TRBOnet Swift is a family of hardware products by Neocom Software, Ltd designed 
for use in MOTOTRBO radio networks. The TRBOnet Swift family hardware is 
presented by RoIP gateways A100 and A200, option board ST002. 

1.3 Contacts 

Region Phone Email & Support 

EMEA +44 203 608 0598 
info@trbonet.com — general and 
commercial inquiries 

support@trbonet.com — technical support 

https://trbonet.com/kb/ — online 
knowledge base  

Americas +1 872 222 8726 

APAC +61 28 607 8325 

 

mailto:info@trbonet.com
mailto:support@trbonet.com
https://trbonet.com/kb/


 
 

2 TRBOnet Swift CPS 1.8 – User Guide 
 

2 Overview 
2.1 About TRBOnet Swift CPS 

TRBOnet Swift CPS is a configuration editor designed for programming MOTOTRBO 
GOB option boards and the TRBOnet Swift family electronic devices with Swift Event 
Logic on board. 
TRBOnet Swift CPS can work with configuration files and with configurations loaded 
from devices. In addition, it can update the device firmware, read device memory, and 
program devices with an extended configuration provided by Neocom Software, Ltd 
by customer request. 
The intuitive user interface serves to facilitate every step of device programming. 

• Automatic detection of a connected device 

TRBOnet Swift CPS can connect devices using the USB, LAN, or OTAP interface. 
Devices connected to USB are detected automatically. The number of 
connected devices is only limited by the number of USB ports available on the 
computer. 

• Device-specific settings only 

TRBOnet Swift CPS displays the configuration settings specific to a given type 
of device. Where possible, the recommended settings are set by default.  

• Event Logic defined by rules 

Rule Editor facilitates the process of building Event Logic rules from 
configurable components. This tool allows the user to create new rules from 
copies with minimum effort. 

• Sample configuration files 

TRBOnet Swift CPS comes with a set of sample configuration files for all 
supported devices. Sample configurations include the default device-specific 
settings and demonstrate the use of rules for setting up various Event Logic 
features. Sample files can serve as a starting point for creating device 
configurations when other configuration sources are not available. 
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2.2 About Swift Event Logic 
TRBOnet Swift Event Logic is a unified programmable environment supported by 
TRBOnet Swift DT500, TRBOnet Swift ST002, and MOTOTRBO GOB. The basic 
configurable components of Swift Event Logic include events, conditions, and actions. 
Swift Event Logic extends the capabilities of a standard radio network by 
implementing special features such as Lone Worker, Man Down, No Movement, Crash 
Detect, Speed Limit, Telemetry, GeoRoaming, and GeoFencing. 

2.3 Software Requirements 
Category Requirements 

CPU Intel Core i3 

Memory 4 GB 

Display 1280x1024 minimal resolution, 1600x900 recommended resolution 

Additional Devices Speakers 

Supported OS Windows 7, Windows 8, Windows 10 

Software .NET Framework 4.6.1 

2.4 Licensed Features 
TRBOnet Swift Event Logic features are available on terms of commercial licensing. 
The following table describes the licenses that you need to purchase and activate on 
your device to use particular features. 

Note: If a configuration uses commercial features, they do not work until the 
required license is purchased and activated on that device. 

License Description Related features 

Location Tracking This license enables getting GNSS 
and iBeacon data from the radio. 

Sending GNSS reports to TRBOnet 
Server, Speed Limit, GeoRoaming, 
Geofencing, etc. 

Personal Safety This license enables getting data 
from the G-meter. 

Man Down, No Movement, Crash 
Detect, etc. 

Voice Recording This license enables downloading 
voice call records and playing them 
back. 

Voice Recording 

 
The Lone Worker feature is enabled on a device when any of the above licenses is 
activated. 
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3 Installation and Upgrade 
The following table describes how to install, uninstall, upgrade, and load new firmware 
to your TRBOnet Swift CPS software. 

Notes: The distribution package for TRBOnet Swift CPS is available for download at 
www.trbonet.com. From the main page, go to Downloads and click 
Firmware. Click to download the latest version of Swift Utilities Pack. 
Before installing TRBOnet Swift CPS make sure that your computer meets the 
minimum software requirements. For more information, refer to section 2.3, 
Software Requirements (page 3). 

To install TRBOnet Swift CPS: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift CPS 
setup wizard. Click Next. 

• Accept the terms of the license agreement. Click Next. 
• Click Install, then click Finish to exit the setup wizard. 

To uninstall TRBOnet Swift CPS from your computer: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift CPS 
setup wizard. Click Next. 

• Select the Remove option. 
• Click Remove, then click Finish to exit the setup wizard. 

To upgrade TRBOnet Swift CPS to a newer version: 

• Install the new version on your computer as described above. 
Uninstalling the previous version of the product is not required. 

To load new firmware to TRBOnet Swift CPS: 

Note: The firmware for all supported devices is integrated in TRBOnet Swift CPS. 
When new firmware is issued, you can load it to TRBOnet Swift CPS without 
upgrading the software to the next version. 

• To load firmware to TRBOnet Swift CPS, open the SWU file. The firmware is 
unpacked and installed automatically. 

 

http://www.trbonet.com/
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4 Device Programming 
This section describes how to connect your hardware to a computer for programming, 
how to update firmware, and how to create or update a configuration on a connected 
device. 

4.1 Swift CPS Options 
• On the toolbar, click Tools > Options. 
• In the left pane, select Options > General. 

 

In the right pane, specify the following Swift CPS-related options: 
 Allow changing device firmware type 

Setting this option to ON will allow you to select the device mode when 
updating firmware on the device (see section 4.3,Firmware Update, step 
5). 

 Language 
From the list, select the interface language. 

 Show information drawings 
If you set this option to ON, useful information drawings will be shown at 
the bottom of the right pane when configuring device's Audio Settings 
and I/O Settings. 

 Enable beta features in menu 
If this option is set to ON, all beta features will be shown in Logic section. 

Note: This option is intended for advanced users only. 

 Path to external Audioplayer 
This is the full path to the TRBOnet audio player. If required, click the 
ellipsis button (…) and specify a different path for the audio player. 

 



 
 

6 TRBOnet Swift CPS 1.8 – User Guide 
 

4.2 Device Connection 
TRBOnet Swift CPS can communicate with supported hardware over USB, LAN, or OTA 
(Over the Air). To use a particular interface, launch TRBOnet Swift CPS, expand the 
Connection menu and choose the required option. 

 

The selected connection appears on the status bar, for example, "Connection: USB". 

USB connection 
A USB connection is recommended for programming any supported hardware. This 
connection does not require any settings. Just connect the programming cable to the 
device and to a USB port of your computer, then launch TRBOnet Swift CPS and work 
with the device. Use the programming cable supplied with your device or 
recommended for use by the manufacturer of the device. 

LAN connection 
A LAN connection can be used for programming any hardware that can be connected 
to an IP network. Your device must be powered and connected to the same LAN where 
TRBOnet Swift CPS is installed. A brand new device has the following default IP 
settings: 

• IP address: 192.168.0.[xxx] 
• Subnet mask: 255.255.255.0 
• Default gateway: 192.168.0.1 

You may need to adjust the IP settings of your computer accordingly. 

Over the Air connection 
An OTA connection is used for over-the-air programming of endpoint devices such as 
DT500 connected to a MOTOTRBO radio or an option board ST002 installed into a 
MOTOTRBO radio. 

• On the Connection menu, select Over the Air, and go to 
Options > Connections. 
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• Specify the following OTA connection settings: 

Setting Description 

Gateway The gateway that can establish an IP connection with TRBOnet Swift 
CPS and that can communicate with the device over the air. Values: 

• TRBOnet Server 
• Swift IP Gate A100/A200 

IP address The IP address of the gateway selected above. 

Port The Forward Data service port of the TRBOnet Server (if selected 
above). Default: 4011 

To get the port number, launch the TRBOnet Enterprise (PLUS) Server 
application and select Radio Systems > Services in the left pane. Find 
the port number under the Forward Data service option. 

Note: Make sure that the Forward Data service option is selected. 

Response timeout The time period, in seconds, to wait for a response from the server side 
(TRBOnet Server, Swift IP Gate). 

4.3 Firmware Update 
Before you proceed to device programming, we recommend that you update the 
device firmware to the latest version using TRBOnet Swift CPS. 
If your device is already configured, the configuration will be cleared from the device 
memory after you update the firmware. To preserve the current configuration, save it 
to a file and reload it to the device after the firmware update. 

To update the firmware version: 

 Launch TRBOnet Swift CPS on your computer. 
 Connect your device to the computer and point the connection type in the 

TRBOnet Swift CPS settings. For details, refer to section 4.2, Device Connection 
(page 5). 

 On the Device menu, click Update Firmware. 
 In the Firmware update window, select your device connected through USB. 
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Note: If TRBOnet Swift CPS cannot detect a USB device, the cause may be the 
hardware driver not found on your computer. For details, refer to the user 
manual provided for your device. 

 Open the Mode menu and click the preferred mode. 

Note: If the Mode menu is read-only, close the Firmware update window. Then 
open the Tools menu and click Options. Make sure that the Enable 
changing device mode option is set to ON. 

 In the Firmware update window, open the Update to menu and click the 
firmware version to which the device will be updated. You can select the latest 
version or roll back to an earlier version if required. 

 Click Update to start the firmware update. The progress bar shows the progress 
of the operation. 

4.4 Device Configuration 
This section describes how to configure Swift Event Logic and connections with 
external hardware, how to work with configuration files, and how to perform read and 
write operations on a device. 

4.4.1 Configuration Files 
This section describes operations with a configuration file in TRBOnet Swift CPS. 

 Opening a Configuration File 
In TRBOnet Swift CPS, you cannot create a configuration file from scratch. Instead, you 
need to open an existing configuration file, make the required changes, and save the 
result to a file or load it to a connected device. 
You can open a configuration from a file, for instance, from a sample file installed with 
TRBOnet Swift CPS. Or, you can read a configuration file from a connected device. 

To read a configuration from the device: 
• Connect a configured device to a computer. Select the connection type. 
• On the Device menu, click Read, or click the Read button on the toolbar. 
• (Optional) Specify the connection settings and click Read. 
• (Optional) If more than one connected device is detected, click the required 

device in the dialog box. Then click OK. 

To open an existing configuration file: 
• On the File menu, click Open. Go to the required folder and click the 

configuration file. Then click Open. 
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• Double-click the SWR file in the folder. 
• Drag the SWR file and drop it within the TRBOnet Swift CPS window. 

To open a sample configuration file: 
• On the Help menu, click Samples. 
• In the folder, click the sample file intended for your type of device. Click Open. 

TRBOnet Swift CPS displays each opened configuration on a separate page. The label 
of the page displays the name of the opened file or the device and the used 
connection. 
If you open multiple configurations, they appear each on a separate page. You can 
work with them in parallel. 

 Updating a Configuration File 
An opened configuration appears on a separate page in the main window of TRBOnet 
Swift CPS. The left panel of the page displays the logical sections of the configuration. 
If you click a particular section, the right panel shows the related configuration 
settings. 
The Device section includes the general information such as the type of device 
(model), the firmware version, the last date when the configuration was updated on 
the device, and the statuses of all features that require a license. To learn how to apply 
a license, refer to section 5, Activation of Features (page 36) 

 

Note: When you open a configuration file, the device information and the license 
information apply to the device whose configuration has been saved to the 
file. 

If a device has external interfaces (RS-232, GPS, GPRS, other), the Device section 
includes additional sub-sections to configure communication through each external 
interface. To learn how to configure external connections of a device, refer to section 
4.4.2, Connection Settings (page 10). 
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The Logic section includes the Swift Event Logic configuration settings such as rules, 
report profiles, network profiles, and other. If a device does not support Swift Event 
Logic, the Logic section is hidden. To learn how to configure Swift Event Logic settings, 
refer to section 4.4.3, Swift Event Logic (page 13). 

 Saving a Configuration File 
You can save an opened configuration to a file or load it to the memory of a connected 
device. If you just close the configuration page or the application window, you cancel 
all the changes without a prompt. 

To write a configuration to a connected device: 
• On the Device menu, click Write, or click the Write button on the toolbar. 
• (Optional) Specify the connection settings and click Write. 
• (Optional) If multiple connected devices are detected, point the required 

device in the dialog box. Click OK. 
• (Optional) If you write the configuration initially created for a different type of 

device, confirm the operation. 

Note: A configuration written to a different type of device includes all definitions 
from the Logic section of the left panel. Connection settings in the Device 
section are not written to a different type of device. 

To save a configuration to a file: 
• On the File menu, click Save As. 
• Go to the required folder. Click an existing SWR file to be updated, or type the 

name of a new configuration file to be created. Click Save. 

4.4.2 Connection Settings 
This section describes how to configure connections between your device and external 
hardware. To configure connections, open a configuration in TRBOnet Swift CPS as 
described in section 4.4.1.1, Opening a Configuration (page 8). The Device section in 
the left pane includes all connection settings available for the given device. 

 Audio Settings 
A configuration includes the Audio Settings section if you configure TRBOnet Swift 
A200 that is connected with the radio through the audio cable. Adjust the volume of 
the transmitted audio signal by changing the following settings. 

Setting Description 

Level of the input audio 
signal 

The level of the input audio signal in the range of -42Db to 20 Db. 

Level of the output audio 
signal 

The level of the output audio signal in the range of -42Db to 20 Db. 

Level of amplification of 
the input audio signal 

The amplifier of the input audio signal. 

Input for Audio The divider of the input audio signal. Values: 

 IN1: The divider is disabled (default). 
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Setting Description 

 IN2: Switch to this setting to the switch to lower the level of the 
input signal from the connected non-MOTOTRBO radio. 

 

 I/O Settings 
When you configure TRBOnet Swift A200, a device configuration includes 
the I/O Settings section. 

 

In the right panel, the physical I/O connector pins of Swift A200 appear as labels Pin 1 
through Pin 8. For each connected physical pin, specify the settings as described in 
the following table. 

Setting Description 

Pin function The function of the I/O pin. The value depends on the connected 
hardware: 

 If the pin is connected to external hardware, select the matching 
logical pin in TRBOnet software. Values: Input [1 : 10], Output 
[1: 10] 

 If the pin is connected to a radio connector pin through the 
service cable, specify the pin function. Values: Radio control 
input, Radio control output, Input CSQ, Output PTT. 

 If the pin is not connected, select Unassigned. 

Active level The active level of the physical pin. Values: Active Level High, 
Active Level Low. 

Pullup The pull-up. Values: Pullup Off , Pullup +5 V. 

Logical level (pullup off, 
input pins only)  

The logical level of the input pin. Appears if the pull-up is off. Values: 
Logic level [1.8 V | 3.3 V | 5 V TTL | 5 V CMOS | 9 V | 12 V].  

Default level (output pins 
only) 

The level set on the output pin by default after restart of the device.  
Values: Default level Low, Default level High, Save last state. 

Debounce The debounce of the input signal. Values: Debounce [off | 100 | 200 
| 300 | 500 | 700 | 900] ms. 
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Note: To learn the details about configuring the I/O pins of Swift A200, refer to the 
TRBOnet Swift A200 User Manual. You can download the TRBOnet Swift 
A200 documentation from www.trbonet.com. 

 NRF Settings 
A configuration includes the NRF Settings section when you configure Swift A200 
(NRF RoIP Gateway) or Swift ST002. 
Configure the wireless (NRF) connection between a device and the option board 
installed in the connected radio. Both parties have the Nordic RF transceiver onboard. 

Setting Description 

Data transfer rate The data transfer rate for wireless communication. Values: 1 Mbps, 2 Mbps. 
Default: 2 Mbps. 

Channel The channel for wireless communication with the radio. Range: 0 to 125. 

Power The power of the device. Values: 20, 60, 250, 1000 µW. 

Default: 1000 µW. 

Address The group call ID on the NRF radio network. For wireless communication on 
an NRF network, the modules need to be programmed with the same 
address. Default: E7:E7:E7:E7:E7. 

Address width The number of sections (left to right) in the NRF address (above) to be 
considered. Values: 3, 4, 5. Default: 3. 

 Network Settings 
A configuration includes the Network Settings section when you configure Swift 
A200. To configure the IP connection between the device and the TRBOnet network, 
specify the following settings. 

Setting Description 

IP address The IP address assigned to the device. 

Subnet mask The mask of the subnet to which the device belongs. 

Default gateway The default gateway of the IP network. 

MAC address The network address of the device. 

 

http://www.trbonet.com/
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4.4.3 Swift Event Logic 
This section describes how to configure the Swift Event Logic settings on a device. 

 Operations with Logic 
You can import and export the Logic section of a configuration using commands on 
the Logic Information page. 

 

Use these commands only when requested by the support team of the product 
vendor. In all other cases, manage the device configuration as described in section 
4.4.1, Configuration Files (page 8). 

To save logic to XML file: 
• On the Logic Information page, click Save as xml in the right panel. 
• Go to the destination folder and save the file with the preferred name. 

To import logic from XML or SWR file: 
• On the Logic Information page, click Clear in the right panel. The Logic 

section now displays Logic information only. 
• Click Import logic. 
• In the system dialog box, select the type of file with the external logic – XML or 

SWR. Select the file and click Open. 
The logic imported from SWR is displayed in the Logic section. The logic 
imported from XML is not displayed, the Logic section only includes Logic 
information. 
The Logic information section shows the name of the source file. 
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 Report Settings 
If configured accordingly, a device can collect incoming information in the memory, 
create data sequences (reports), and send them to TRBOnet Server over a radio 
channel or via a Wi-Fi connection. Reports typically include the current location of a 
connected radio and telemetry from the input pins. 
To define rules for creating and sending reports, create a profile with report settings. 
You can create as many profiles as necessary. One profile must be indicated as default. 
The default profile is loaded to the device memory at startup. 
To configure report settings in an opened configuration, click Reports in the Logic 
section of the navigation panel. 

 

The Report Profiles page displays all profiles with report settings that are defined in 
the opened configuration. 

• Send battery status 
Select this option so that the radio will include battery status each time it 
sends a data packet to TRBOnet Server. 

• Include telemetry data in each report 
Select this option so that the radio will include telemetry data in each report. 

In the default configuration, there are two predefined report profiles: Radio Report 
Profile and Wi-Fi Report Profile. 
You can manage report profiles as described below. 

To create a profile: 

• Click Add. 
• In the Edit Report Profile window, specify the report settings as 

described in section 4.4.3.2.1, Editing Report Profile (page 15). 
• Click OK. 



Device Programming 

15 
 

To set a default profile: 
• Select the profile and click Set Default, 

or 
select the Default box next to the profile name. 

To edit a profile: 
• Select the profile in the list and click Edit, 

or double-click the profile. 
• Edit the report settings as described in section 4.4.3.2.1, Editing Report 

Profile (page 15). 
• Click OK. 

To delete a profile: 
• Click the Delete icon next to the profile name. 

The profile is deleted and cannot be restored. If you delete the default profile, 
the last profile in the list becomes the default one. 

Note: You cannot delete the last remaining profile. 

4.4.3.2.1 Editing Report Profile 
Specify the report settings in the Edit Report Profile window. Click OK to save the 
profile. 

 

• Profile name 
Click this field to enter/edit the name of the report profile. 

GNSS Report Creation 
• Add GNSS data every (m) 

The GNSS data will be added to the report each time the specified distance (in 
meters) is traveled. 
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• Add data at minimum direction change 
The minimum direction change, in degrees, at which GNSS data is added to 
the report. 

• Add GNSS data every (sec) 
The GNSS data will be added to the report each time the specified time 
interval (in seconds) elapses. 

Report Sending 
• Type of channel for sending a report 

From the drop-down list, select one of the following options: 
 Do not send 

Creating and sending GNSS reports is disabled. 
 On the selected channel 

The radio sends reports on the currently selected channel. 
 On the data channel 

The radio sends reports on the data channel. 
• Send report every (m) 

The radio will send a report each time the specified distance (in meters) is 
traveled. 

• Send report every (sec) 
The radio will send a report each time the specified time interval (in seconds) 
elapses. Note that in Wi-Fi Report Profile, the recommended value for this 
option is 6 sec. 

• Number of retries 
The number of retries for sending a report on the radio channel. 

• Waiting time for delivery confirmation 
The time interval, in seconds, to wait for a delivery confirmation. 

Advanced 
• Synchronize time with TRBOnet Server 

Select this checkbox so that time on the radio will be synchronized with 
TRBOnet Server. 

 Network Settings 
You can also specify settings for the network media over which reports are sent to 
TRBOnet Server. 
To configure network settings, click Networks in the Logic section of the navigation 
panel. 
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The Network Profiles page displays all profiles with network settings that are defined 
in the opened configuration. 
In the default configuration, there are two predefined network profiles: Radio 
Network Profile and Wi-Fi Network Profile. 
You can manage the network profiles as described below. 

To create a profile: 
• Click Add. On the drop-down menu, click either Radio Network Profile or 

Wi-Fi Network Profile. 
• Specify the network settings in the appropriate Network Profile window as 

described in sections 4.4.3.3.1 or 4.4.3.3.2. 
• Click OK. 

To set a default profile: 
• Select the profile and click Set Default, 

or 
select the Default box next to the profile name. 

To edit a profile: 
• Select the profile in the list and click Edit, 

or double-click the profile. 
• Edit the network settings as described in sections 4.4.3.3.1 or 4.4.3.3.2. 
• Click OK. 

To delete a profile: 
• Click the Delete icon next to the profile name. 

The profile is deleted and cannot be restored. If you delete the default profile, 
the last profile in the list becomes the default one. 

Note: You cannot delete the last remaining profile. 
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4.4.3.3.1 Editing Radio Network Profile 
Specify the network settings in the Radio Network Profile window. Click OK to save 
the profile. 

 

• Profile name 
Click this field to enter/edit the name of the radio network profile. 

• MOTOTRBO network CAI +1 
The MOTOTRBO network identity (CAI) increased by 1. This increment is 
required to send data to TRBOnet Server. Example: If MOTOTRBO CPS defines 
the network CAI 12, enter 13. 

• TRBOnet Server ID/Radio ID 
The unique radio ID of TRBOnet Server in the MOTOTRBO network. 

• TRBOnet Server port 
The port of the PC where TRBOnet Server is running (4104, by default). 

4.4.3.3.2 Editing Wi-Fi Network Profile 
Specify the network settings in the Wi-Fi Network Profile window. Click OK to save 
the profile. 

 

• Profile name 
Click this field to enter/edit the name of the Wi-Fi network profile. 

• TRBOnet Server IP 
The IP address of the PC where TRBOnet Server is running. 

• TRBOnet Server port 
The port of the PC where TRBOnet Server is running (4180, by default). 
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 Regions 
The Event Logic rules use geographical regions as input parameters. A region is an 
area selected on the online map and given a unique name. Allowed are polygonal 
regions and circular regions with the maximum radius of 65.00 kilometers. 
To define regions, click Regions in the Logic section of the navigation panel. 

 

In the right pane, select the Enable module option. 
In the Presence timeout box, specify the minimum duration of stay within (if entered) 
or out (if left) of the region. This value will be used for Geofencing events. 
Regions appear on the map as colored areas. The region names are displayed in the 
right panel. 
The following useful features will help you work with the map: 

To pan the map: 
• Keep the left mouse button pressed and move the mouse cursor to the 

required direction. 

To adjust the scale level: 
• Scroll the mouse wheel to zoom the map. 

To select a different map: 

• Click the Map Settings button ( ) in the right panel. 
• In the Map Configuration window, from the Tile source drop-down list, 

select the preferred map. 
• Click Apply. 

Note that in the offline mode, the map is loaded from cache. 
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To select the cache folder: 

• Click the Map Settings button ( ) in the right panel. 
• In the Map Configuration window, click the Search button next to the Root 

cache directory field. Find the destination folder and confirm the choice. Or, 
specify the folder path manually. 

• Click Apply. 
You can perform the following operations with map regions. 

To add a polygonal region: 

• Click the Create Polygonal Region button ( ). 
• Click the map where the region border will start. Draw the shape of the region, 

clicking where you want to place nodes. The added nodes connected with lines 
make a region border. 

• Double-click to finish. The first and the last nodes will be connected with a line. 
The new polygonal region will appear in the right panel under the Regions 
List. 

To add a circular region: 

• Click the Create Circular Region button ( ). 
• Click the map where the center of the region will be located. 
• Release the mouse button and move the cursor away from the center.  The 

distance from the center (in km) is displayed near the region. The radius of a 
circular region is restricted to 65 km. 

• Double-click to finish. The new circular region will appear in the right panel 
under the Regions List. 

To edit a region: 
• Double-click inside the region on the map, or in the Regions List. 

The region on the map is highlighted and all of its nodes are displayed. 
• To drag a node to a different position, click it and keep the mouse button 

pressed. To drop the node, release the mouse button. 
• To delete a node, right-click it. 
• To move the entire region, point to its central point, click and drag it to the 

new position on the map. 
• To save changes, double-click on the map. Or, press Esc to cancel editing. 
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To import regions: 

• Click the Import Regions button ( ). 
• Confirm to replace all regions. 
• In the Import from KML window that appears browse for the desired *.KML 

file, and click Open. 

To export regions: 
• Select desired regions. 

• Click the Export Regions button ( ). 
• In the Export to KML window that appears locate the folder where you want 

to save the file, type a filename, and click Save. 

To delete a region: 
• Select the region under the Regions List and click the Delete button. 

Note: The deleted region cannot be restored with the Undo command. 



 
 

22 TRBOnet Swift CPS 1.8 – User Guide 
 

 iBeacon-based Tracking 
To configure iBeacon tracking, select the iBeacon-based Tracking section in the left 
pane. 

 

In the right pane, specify the following iBeacon-related settings: 
• Enable module 

Select this option to enable the iBeacon-based Tracking module. 
• iBeacon: Major ID/ iBeacon: Minor ID 

Enter the Major ID and Minor ID (the values or the ranges of values) of the 
iBeacons that will be used for iBeacon-based Tracking. 

• RSSI threshold 
Set the minimum signal strength, in negative decibels, of an iBeacon to 
consider it as discovered. 

• When an iBeacon is discovered 
From the drop-down list, select what to do when an iBeacon is discovered. 
 Add to report 

This will add information on a discovered iBeacon to the report. 
 Immediately send to TRBOnet 

This option means that the corresponding report will be sent immediately. 
 Immediately send to TRBOnet with interrupt 

This option means that the corresponding report will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 

• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered as 
lost. 

• When an iBeacon is lost 
From the drop-down list, select what to do when an iBeacon is lost. 
 Add to report 

This will add information on a lost iBeacon to the report. 
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 Immediately send to TRBOnet 
This option means that the corresponding report will be sent immediately. 

 Immediately send to TRBOnet with interrupt 
This option means that the corresponding report will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 

• Enable debug mode 
Select this option to show debug information on the radio display. 

 Security Tokens 
To configure the iBeacon-based user authentication, select the Security Tokens 
section in the left pane. 

 

In the right pane, specify the following Security Tokens-related settings: 
• Enable module 

Select this option to enable the Security Tokens module. 
• iBeacon: Major ID/ iBeacon: Minor ID 

Enter the Major ID and Minor ID (the values or the ranges of values) of the 
iBeacons that will be used as security tokens. 

• RSSI threshold 
Set the minimum signal strength, in negative decibels, of an iBeacon to be 
considered as discovered. 

• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered as 
lost. 

• Enable debug mode 
Select this option to show debug information on the radio display. 
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 Dynamic Channel Selection 
The Dynamic Channel Selection feature allows for automatic selection of the radio 
zone/channel depending on the geographical region and/or the proximity of certain 
iBeacons. 

• In the left panel, select the Dynamic Channel Selection section. 

 

In the right pane, specify the following Dynamic Channel Selection-related 
settings: 

• Location priority 
From the list, select the priority to use for Dynamic Channel Selection. 

• Set default channel 
Select this option and specify the default channel and zone. This channel/zone 
will be automatically set on the radio when its location is not available or 
outside designated regions/iBeacons. 
 Zone 

Enter the default zone. 
 Channel 

Enter the default channel. 
• Lock selected channel 

Select this option so that the radio will prevent the user from changing the 
automatically selected channel. 

• Add 
Click this button and specify the following Dynamic Channel Selection 
parameters: 
 Zone 

Enter the zone to be set automatically when the radio stays in the selected 
region and/or in the vicinity of the specified iBeacon(s). The value 0 means 
that the current zone won't be changed. 

 Channel 
Enter the channel to be set automatically when the radio stays in the 
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selected region and/or in the vicinity of the specified iBeacon(s). The value 
0 means that the current channel won't be changed. 

 Region 
From the list, select the region within which the radio must stay so that 
the specified channel/zone will be set automatically. 

 iBeacon: Major ID/ iBeacon: Minor ID 
Specify the Major ID and Minor ID of the beacon(s) in the vicinity of which 
the radio must stay so that the specified channel/zone will be set 
automatically. 

 Rules 
A rule describes a specific event to which a programmed device will respond with a 
predefined sequence of actions, such as playing back tone or displaying text on the 
radio display, sending text to other radios, changing the radio channel, sending 
alarms, and other. 

 

To configure rules, expand the Logic section and click Rules in the left panel. 
The Rules page displays a predefined set of rules. You can manage rules as described 
below. 

To create a rule: 
• Click Add and on the drop-down menu click the event type. 
• In the Create Rule window, define the rule as described in section 4.4.3.8.1, 

Creating/Editing a Rule (page 26). 

To create a copy of an existing rule: 
• Select the rule in the list and click Copy. 

A copy of the selected rule is added to the list. 
• Edit the rule name and settings as described below. 
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To edit a rule: 
• Double-click the rule or select it in the list and click Edit. 
• Modify the rule settings in the Edit Rule window as described in section 

4.4.3.8.1, Creating/Editing a Rule (page 26). 

Delete a rule 
• Select the rule in the list and click Delete. 
• Confirm the deletion in the prompt dialog box. 

Enable all rules that you want to write to the device memory and be executed at 
runtime. 

To enable a rule: 
• Select the rule in the list and click Enable, 

or select the Enabled box next to the rule name. 
4.4.3.8.1 Creating/Editing a Rule 

The Create/Edit Rule window serves for creating and/or editing the Event Logic rule. 

 

To define a rule: 

 Specify the name of the rule in the Name field (Rule: Name). 
 Specify the state of the rule (State: Disabled/Enabled). 
 In the Event pane, specify the properties of the event. For a brief description of 

the event, click the "i" icon at the window's top right. 
 In the right pane, click Add Step. This will add an additional step to the set of 

actions. Double-click the step that appears and enter the duration, in seconds. 
If you click Add Step > Add Restart, a 'Restart all steps' action will appear at 
the bottom of the set of steps/actions. 

 In the right pane, select a step and click Add Condition. You can add as many 
conditions as required. Configure conditions as described in section 4.4.3.8.3, 
Conditions (page 29). 

 In the right pane, select a step add click Add Action. Configure each action as 
described in section 4.4.3.8.4, Actions (page 30). 

 Click OK to save the rule. 
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4.4.3.8.2 Events 
The following table summarizes information about all supported events and their 
configurable properties. 

Event Description 

Start of Device This event is triggered when the radio starts up. 

Geofencing This event is triggered when the radio enters/exits the designated region for a 
time longer than the wait timeout. 

Properties: 

 Region: Select the region the borders of which are monitored. 
 Direction: Select if the region is entered or left. 

Swift Command This event is triggered when the Swift command is received from TRBOnet 
Server. Properties: optional parameters 1, 2. 

Telemetry Input This event is triggered when the status of any I/O pin has changed on the 
device. 
Properties: 

 Telemetry: Select the Input pin #. 
 Trigger: Select the type of change occurring to the pin (turned on, off or 

toggled) 

Incoming Call This event is triggered when the incoming radio call has started/ended. 

 Call trigger: Select whether the call is started or ended. 
 Call from: Select whether the calling party is the radio or radio group. 
 Group ID: Enter the radio ID of the radio or radio group. 
 Enable debug mode: Select this option to show debug information on the 

radio display. 

Radio Channel This event is triggered when a different channel and/or zone is selected on the 
radio. 

 Zone: Enter the zone number. 
 Channel: Enter the channel number. 

Radio Button This event is triggered when the designated radio button is pressed/released. 

 Button: Select the radio button. 
 Action: Select the type of action. This can be Short press, Long press, or 

Release. 

iBeacon This event is triggered when an iBeacon is discovered/lost. 

 iBeacon trigger: Select whether the iBeacon is discovered or lost. 
 Major ID: Enter the beacon’s major ID exactly as specified in the iBeacon 

device. 
 Minor ID: Enter the beacon’s minor ID exactly as specified in the iBeacon 

device. 

Security Tokens This event is triggered when one of the following Security Tokens event has 
occurred: 

 User Logged In 
 User Logged Out 
 Token Not In Range. 

Wi-Fi Network This event is triggered when a Wi-Fi network is connected/disconnected. 

 Network trigger: Select whether the Wi-Fi network is connected or 
disconnected. 

 Wait timeout: Enter the minimum duration of staying 
connected/disconnected. 
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Event Description 

Rollover Detection This event is triggered when the mobile radio tilt is below the threshold angle 
for a time longer than the pre-alarm duration. 

 Threshold angle: The minimum vertical angle (in degrees) at which the 
radio is still considered up. 

 Pre-alarm duration: The timeout (seconds) after detecting the radio tilt. 

Note: After installing the radio in the working position in a car, you need to 
set a custom axis orientation of the accelerometer. This is done by 
clicking Set a custom axis orientation of the accelerometer in the 
Service page. 

 Enable debug mode: Select this option to show debug information on the 
radio display. 

Crash Detection This event is triggered when the radio acceleration exceeds the impact 
threshold, the speed drops to zero within the idle timeout, and then there is no 
movement for the duration of the wait timeout. 

 Impact acceleration threshold: The maximum acceleration that shall be 
exceeded to suspect a car crash. 

 Wait timeout: The timeout, in seconds, that starts after the suspected car 
crash and during which no acceleration measurements are taken. 

 Acceleration threshold: The minimum acceleration that must be gained 
during the control time to confirm the normal speed mode. 

 Idle timeout: The timeout, in seconds, that starts after the wait timeout. 

Lone Worker This event is triggered when there is no user activity for a time longer than the 
response time. The timer will restart after pressing any radio button or knob. 

 Response time: The timer, in seconds, that restarts after a button push, a 
talk, or use of the channel selector was detected on the radio. 

No Movement This event is triggered when the radio acceleration is below the threshold for a 
time longer than the wait time. 

 Acceleration threshold: The minimum acceleration at which the radio is 
still considered to be at normal speed. 

 Wait time: The timeout, in seconds, that starts after the radio acceleration 
has fallen below the threshold. 

Man Down This event is triggered when the radio tilt is below the threshold angle for a 
time longer than the pre-alarm duration. 

 Threshold angle: The minimum vertical angle, in degrees, at which the 
radio is still considered up. 

 Pre-alarm duration: The timeout (seconds) after detecting the radio tilt. 
 Enable debug mode: Select this option to show debug information on the 

radio display. 

Note: Before enabling this event, you need to set a custom axis orientation of 
the accelerometer. This is done by clicking Set a custom axis 
orientation of the accelerometer in the Service page. 

Speed Limit This event is triggered when the measured speed exceeds or falls below the 
threshold. 

 Speed: The math operator. Values: greater than, less than. 
 Threshold: The maximum or minimum allowed speed in kilometers per 

hour. 

Note: The speed measurement error may be as high as 5 to 10%, depending 
on the type of a two-way radio (less for mobile, higher for portable) and 
on the satellite signal reception quality. 
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4.4.3.8.3 Conditions 

In the Conditions panel of the Create/Edit Rule window, add one or more conditions 
for the event to be handled. 

Note: Adding conditions to a rule is optional. If you add multiple 
conditions, ALL OF THEM must be TRUE for the actions to be 
executed. 

 

To add a condition: 
• In the right pane of the Create/Edit Rule window, select a step and click 

Add Condition. In the drop-down menu, click the desired condition. 
• In the dialog box that opens, specify the required condition parameters. 
 Geofencing 

In the Geofencing Condition dialog box specify the following parameters: 
• Region 

From the drop-down list, select the desired region. 
• Position 

From the drop-down list, select 'Inside' or 'Outside' position in a region. 
 Selected Radio Channel 

In the Selected Radio Channel Condition dialog box, specify the Channel 
and Zone. 

 iBeacon In Range 
In the iBeacon In Range Condition dialog box specify the iBeacon's 
Major ID and Minor ID. 

 Flag State 
In the Flag State Condition dialog box specify the Flag (a number from 1 
to 32) and its State (On/Off). 

 Telemetry Input State 
In the Telemetry Input State Condition dialog box specify the Telemetry 
input (Input 1 – Input 8) and its State (On/Off). 
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Once added, the new condition will appear at the beginning of the corresponding 
step. The order of conditions in the list cannot be changed and does not affect the 
logic. 

To edit condition settings: 
• Double-click the desired condition. 

In the dialog box that opens, edit the required condition parameters. 

To delete a condition: 
• Select the desired condition and click the Delete button. 

4.4.3.8.4 Actions 
In the Actions panel of the Create/Edit Rule window, add one or more actions to 
execute when the event has occurred and all conditions have been confirmed. 

To add an action: 

 In the right pane of the Create/Edit Rule window, click Add Action and in the 
drop-down menu click the desired action. 

 In the dialog box that opens, specify action properties and click OK. 

 

A new action with the specified name appears at the last position in the right pane of 
the Create/Edit Rule window. Use Up and Down arrow buttons to adjust the 
execution order of actions. 
To delete an action, click the Delete button. Double-click the required action to open 
its properties for editing. 
The following table summarizes information about all supported actions and their 
configurable properties. 
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Action Description 

Play Tone This action forces the radio to play back the specified tone. Properties: 

 Tone: The tone to be played back. 
 Tone Type: Choose whether to play the tone momentarily or repetitively. 
 Volume shift: The volume boost (in MOTOROLA’s units of measure). 

Play Announcement This action forces the radio to play back a pre-recorded voice announcement. 

 Voice Announcement: Select one of the pre-recorded voice 
announcements. 

Display Text This action forces the radio to display text. 

Properties: 

 Text: Enter the text to display on the radio. 
 Position: The display line from which the text starts. Options: Line 1, Line 

2, Line 3, Line 4. 
 Alignment: Select the alignment of the text. 
 Font: Select the font style (Normal or Bold). 

Send Text This action forces the radio to send text to a specified radio or radio group. 
Properties: 

 Destination: The recipient of the message. Values: radio, radio group. 
 Radio ID: The radio ID of the recipient. 
 Text: The message to be sent. 

Send Alarm This action forces the radio to send a particular alarm to TRBOnet Server. 

Properties: 

 Alarm type: The type of alarm to be sent. Options: Crash Detection, Lone 
Worker, Man Down, No Movement. 

Manage Emergency This action activates/deactivates the alarm mode on the radio. 

Set Radio Channel This action forces the radio to select a different radio channel/zone. 
Properties: 

 Channel: The radio channel to be set. 
 Zone: The zone to be set. 

Note: These are numerical values that are represented in MOTOTRBO CPS, 
Channels>Zone>Channel (in the Position column). 

Send Report This action will send a report to TRBOnet Server. 

 Priority: The values are: 'Immediately send to TRBOnet' and 'Immediately 
send to TRBOnet with interrupt'. The latter option means that a report 
will be sent immediately, interrupting the current transmission, if the 
radio channel is busy. 

Select Report Profile This action forces a device to use the specified profile with report settings. 

Note: A profile with report settings defines rules for sending reports to 
TRBOnet Server. See also section 4.4.3.2, Report Settings (page 14). 

 Profile: Select the report profile to switch to. 

Select Network Profile This action forces a device to use the specified profile with network settings. 

Note: For information on network profiles, see section 4.4.3.3, Network 
Settings (page 16) 

 Profile: Select the network profile to switch to. 



 
 

32 TRBOnet Swift CPS 1.8 – User Guide 
 

Action Description 

Send Swift Command This action will send a Swift command to TRBOnet Server. 

 Command: Select the Swift command to be sent. 
 Parameter: Enter the parameter if the Swift command contains a 

parameter. 
 Destination: Select one of the destinations (TRBOnet, Radio, or Radio 

group). 
 Radio/Group ID: Enter the Radio/Group ID if the Radio or Radio group 

are selected as the destination. 
 Target Device: Select the device connected to the target radios: an 

option board (Swift OB, GOB) or a DT series controller (Swift DT200/ 
DT600). 

 Priority: The values are: 'Immediately send to TRBOnet' and 'Immediately 
send to TRBOnet with interrupt'. The latter option means that the 
selected command will be sent immediately, interrupting the current 
transmission, if the radio channel is busy. 

Set Telemetry Output This action will set the selected telemetry output to the specified state. 

 Action: Select the action for the output (Toggle, On, O). 
 Output: Select the radio's output to perform the specified action on. 

Set Flag This action will set the selected flag to the specified state. 

 Action: Select the action for the flag (Toggle, On, Off). 
 Flag: Specify the flag (a number from 1 to 32). 

Set Power Level This action will set the radio’s transmission power level for the current 
channel. 

 Power: The values are 'Low' and 'High'. 

Set Display Brightness This action will set the radio display brightness to a specified level. 

 Brightness: The values are 'Increase' (one step), 'Decrease' (one step), 
'Maximum', 'Minimum' and 'Default' 

Lock Radio This action will lock/unlock the radio's keyboard. 

Press Button This action will short-press the specified Accessory Button on the radio (No 
Dot Button, 1-Dot Button, or 2-Dot Button). 

 Short press: Select the desired Accessory Button. 

Log Out User This action will log out the user (deallocate the radio). 

Manage Scenario This action will start/stop the desired scenario. See section 4.4.3.9, Scenarios. 

 Scenario: Select the desired scenario. 
 Action: Select either to Start or Stop the desired scenario. 
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 Scenarios 
A scenario is a sequence of steps/conditions/actions that can be then started/stopped 
in a particular place of a rule by clicking Add Action > Manage Scenario. 
To configure scenarios, expand the Logic section and click Scenarios in the left panel. 

 

The Scenarios pane displays a set of the scenarios. You can manage the scenarios as 
described below. 

To create a scenario: 
• In the Scenarios pane, click Add. 
• In the Create Scenario window, define the of steps/conditions/actions as 

described in section 4.4.3.9.1, Creating/Editing a Scenario (page 34). 

To create a copy of an existing scenario: 
• Select the scenario in the list and click Copy. 

As a result, a copy of the selected scenario is added to the list. 
• Edit the scenario name and settings as described below. 

To edit a scenario: 
• Double-click the scenario or select it in the list and click Edit. 
• Modify the scenario settings in the Edit Scenario window as described in 

section 4.4.3.9.1, Creating/Editing a Scenario (page 34). 

Delete a scenario 
• Select the scenario in the list and click Delete. 
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4.4.3.9.1 Creating/Editing a Scenario 
The Create/Edit Scenario window is used for creating and/or editing the scenario. 

 

• Specify the name of the scenario in the Name: field. 
• Click Add Step. This will add an additional step to the set of actions. Double-

click the step that appears and enter the duration, in seconds. If you click 
Add Step > Add Restart, a 'Restart all steps' action will appear at the bottom 
of the set of steps/actions. 

• Click Add Condition and in the drop-down menu, click the desired condition. 
For a description of conditions, see section 4.4.3.8.3, Conditions. 

• Click Add Action and in the drop-down menu click the desired action. 
For a description of conditions, see section 4.4.3.8.4, Actions. 

• Use Up and Down arrow buttons to adjust the execution order of steps/actions. 

4.4.4 Mass Configuration 
You can configure multiple option boards at once by using the Mass Configuration 
mode. The OTA connection is used for over-the-air programming of endpoint devices 
such as DT500 connected to a MOTOTRBO radio or an option board ST002 installed 
into a MOTOTRBO radio. 

• On the toolbar, click Tools > Mass Configuration. 

 



Device Programming 

35 
 

• In the Mass Configuration page, enter the following parameters: 
 Device type 

From the drop-down menu, select either 'Swift OB, GOB', 'Swift DT500' or 
'Swift DT200/ DT600'. 

 OTA Connection 
In this section, specify the OTA (over-the-air) Connection-related settings. 
• Gateway 

The gateway that can establish an IP connection with TRBOnet Swift CPS 
and that can communicate with the device over the air. 
Values: TRBOnet Server, Swift IP Gate: Swift A100/ A200 

• IP address 
The IP address of the gateway selected above. 

• Port 
This is the Forward Data service port of the TRBOnet Server (if selected 
above). Default: 4011. 
To get the port number, launch the TRBOnet Enterprise (PLUS) Server 
application and select Radio Systems > Services in the left pane. Find 
the port number under the Forward Data service option. Also make 
sure that the Forward Data service option is selected. 

• Response timeout 
The time period, in seconds, to wait for a response from the server side 
(TRBOnet Server, Swift IP Gate). 

 File 
Enter the full path name for the configuration file (*.swr) that will be sent to 
the radios specified below. 

 Radio ID range 
Enter the range of Radio IDs to which the configuration file selected above 
will be sent. 

Note: Separate each Radio ID with a comma, for example, 
"105,106,111", or enter the range using the following example: 
"105-111". 

 Retry count 
Enter the number of retries allowed. 

• Once you have specified the desired configuration settings, click Start. 
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5 Activation of Features 
To learn the statuses of all licensed features on a device, connect the device to your 
computer and read the configuration of the device in TRBOnet Swift CPS. In the left 
panel, click Device and License Information. 

 

In the right panel, all the licensed features that are supported by your device are 
marked as Activated, Available for activation, or Not available (not supported on 
your type of device). 

• The Location Tracking license item allows the option board to receive GPS 
and iBeacon location data from the radio. 

• The Personal Safety license item allows the option board to receive 
G-meter data from the radio. 

• The Voice Recording license item allows the option board to receive voice 
recording data from the radio. 

To activate features on a device: 

 Click Activate features. 
 In the Activate features window, enter the license key and click Check. 
 If the license key is valid, the Activate features window displays all features 

included into the license. You can learn how many times each feature was 
activated on different devices using this license, and how many more 
activations are allowed. 

 Click the Activate features button. If this button is unavailable (grayed out), 
your device works in the demo mode. Click the Restore features button to 
return to the normal mode and activate all purchased features on the device. 

Note: When you choose the demo mode and then the normal mode on a device, 
the license counter is not incremented. 
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